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IMPORTANT INFORMATION

ABOUT SCAN POINT LOCAL CLIENT
Scan Point Local Client allows you to save exams performed with BladderScan® and FloPoint® Elite systems.

With Scan Point Local Client, you can perform the following tasks:

•	 View ultrasound measurements and images from patient exams.

•	 Save and store images and patient exam data on your computer.

•	 Review and print new and past exams.

•	 Receive calibration alerts and facilitate device maintenance.

STATEMENT OF INTENDED USE
Scan Point Local Client is a desktop utility designed for customers who are not able to connect to Scan Point 
due to system or network limitations. Scan Point Local Client is designed for use with BladderScan BVI 6100, 
BVI 6200, BVI 6400, BVI 9400, and FloPoint Elite instruments.

ABOUT USING THIS MANUAL
If Scan Point does not operate as described in this manual, please contact Verathon® Customer Care or refer to the 
chapter Troubleshooting & Maintenance on page 39. For contact information, visit verathon.com/support.

COMPATIBLE DEVICES
The following devices can be used with Scan Point Local Client in order to upload exam results.

Scan Point Docking Station 

Used with BladderScan BVI 6000 series instruments and the FloPoint Elite Uroflow 
System. Scan Point Local Client can recognize up to four Scan Point Docking 
Stations at one time. 

Note: The Scan Point Docking Station looks very similar to the BladderScan 6000 
series Battery Charger. To ensure that you have the Scan Point Docking Station, 
check that the label on the bottom says, “Scan Point Docking Station.”

Battery Charger/Wireless Hub

Used with BladderScan BVI 9400 series instruments. Scan Point Local Client 
can recognize one Scan Point Wireless Hub, and the hub connects to only one 
instrument at a time.

Scan Point Label Writer (optional) 

Used with BladderScan BVI 6000 series instruments (except the BVI 6300) and 
FloPoint Elite Uroflow System

http://verathon.com/support/
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CAUTIONS
Cautions indicate that use or misuse of the device may cause a problem, such as a malfunction, failure, 
or damage to the product. Throughout the manual, pay attention to sections labeled Important, as these 
contain reminders or summaries of the following cautions as they apply to a specific component or use 
situation. Please heed the following cautions.

If unsaved exam data is not uploaded to Scan Point and the instrument goes into sleep mode or 
turns off, the exam data will be lost.

CAUTION

While exam data is uploading to Scan Point, do not remove the instrument from the Scan Point 
docking station or remove the console battery while data is being uploaded. Scan Point displays 
the percentage of data transferred.

CAUTION

Scan Point allows users to access confidential patient information. Please keep your login 
information secure. Giving your Scan Point access to unauthorized individuals could violate 
HIPAA Rules.

CAUTION
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INSTALLING SCAN POINT LOCAL CLIENT

If Scan Point does not operate as described in this chapter, please contact Verathon® Customer Care or refer to the 
chapter Troubleshooting & Maintenance on page 39.

HARDWARE & SOFTWARE REQUIREMENTS
The following sections summarize how a computer must be configured in order to run Scan Point Local Client.

HARDWARE REQUIREMENTS
Minimum and recommended hardware requirements are summarized in Table 1 below.

Table 1.	 Local Client Hardware Requirements

REQUIREMENT MINIMUM RECOMMENDED

Processor PC with 800 MHz processor PC with 2.0 GHz processor

Video display
Video card and monitor capable of 
800 x 600 resolution.

Video card and monitor capable of 
1024 x 768 resolution

USB Ports Two USB 2.0 ports Three USB 2.0 ports*

Hard drive 200 MB of available space 5 GB of available space

Memory 512 MB 512 MB

Internet access 256k DSL
512k DSL, cable modem, T1 line or other 
high‑speed connection.

Your computer must be minimally certified to EN/IEC / CSA / UL 950 or 60101‑1 standards.

This configuration ensures that compliance to the EN/IEC 60601‑1‑1 system standard is maintained. Any 
person who connects additional equipment to the signal input port or signal output port configures a 
medical system, and is therefore responsible for ensuring that the system complies with the requirements 
of the system standard EN/IEC 60601‑1‑1.

If you need assistance, contact Verathon® Customer Care or your local representative.

IMPORTANT

*	 One USB port each for the BVI 9000 series battery charger/wireless hub, Scan Point docking station, and the label printer. The Scan Point 
host computer may connect with up to four Scan Point docking stations at one time.
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SOFTWARE REQUIREMENTS
Table 2 provides a summary of the recommended and minimum system configurations needed to install and 
operate Scan Point Local Client.

Table 2.	 Local Client Software Requirements

REQUIREMENT MINIMUM RECOMMENDED

Operating system
Microsoft® Windows® 7 with Service 
Pack 1

Microsoft® Windows® 7, Windows 8, 
Windows 8.1, or Windows 10 with all 
service packs and updates installed

Browser

•	 Microsoft® Internet Explorer® 8

•	 Microsoft Edge™ 25 
(Windows® 10 only)

•	 Google Chrome™ version 55

•	 Mozilla® Firefox® version 50

•	 Microsoft® Internet Explorer® 8, 9, 10, 
or 11

•	 Microsoft Edge™ 25 
(Windows® 10 only)

•	 Google Chrome™ version 55

•	 Mozilla® Firefox® version 50

Microsoft® .NET 
Framework®

.NET Framework® version 4.5.1 (This 
software is installed with Scan Point Local 
Client.)

.NET Framework® version 4.5.1 with the 
latest Microsoft® updates installed

Internet access 256k DSL
512k DSL, cable modem, T1 line or other 
high‑speed connection

Adobe® Acrobat® 
Reader*

Adobe® Acrobat® Reader® 6.0 or higher Adobe® Acrobat® Reader DC

*	 Adobe® Acrobat® Reader is available as a free download from http://www.adobe.com.

http://www.adobe.com
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PERFORMING INSTALLATION

Do not connect any Verathon® instruments or accessories to the computer until instructed to do so. This 
includes all of the following devices:

•	 Scan Point docking station (used with 6000 series instruments and the FloPoint® Elite Uroflow System)

•	 Battery Charger/Wireless Hub (used with 9000 series instruments)

If you have accidentally connected one of these devices, do not complete the Add New Hardware 
wizard. Exit the wizard and disconnect your Verathon instruments and accessories before you continue.

However, if you will be using Scan Point Local Client with a 9000 series instrument, be sure that the 
power adapter and the USB cable are properly connected to the wireless hub before you continue.

IMPORTANT

Before you install Scan Point Local Client, familiarize yourself with the information in this manual, 
particularly the Hardware & Software Requirements on page 3. Make sure that your computer has the 
correct operating system and web browser versions installed and that your Windows® logon account has 
administrative permissions on your computer. In addition, make sure that your web browser is configured to 
allow pop‑up windows.

Note: The dialog boxes displayed on your screen may differ slightly from those illustrated in the following 
steps. If this happens, follow the instructions in the dialog boxes displayed on your screen.

Procedure 1.	 INSTALL ADOBE ACROBAT READER

Scan Point Local Client uses Adobe® Acrobat® Reader (version 6.0 or higher) to print labels and patient 
reports. Adobe® provides Acrobat® Reader software free of charge.

1.	 In a web browser, visit the Adobe® web site at http://www.adobe.com. 

2.	 On the Adobe® home page, click the Acrobat Reader link. 

3.	 On the Acrobat® Reader installation page, clear the Optional Offer check box if one is present, and 
then click the Install Now button. 

4.	 Follow the instructions in order to complete the Acrobat® Reader installation.

Note: After installing Acrobat® Reader but before using Scan Point Local Client, you must run Acrobat® 
Reader once to accept its End User License Agreement.

Procedure 2.	 INSTALL THE SCAN POINT LABEL WRITER (OPTIONAL)

1.	 Install a roll of labels into the Label Writer. 

2.	 Plug the power cord of the Label Writer into a wall outlet.

3.	 Attach the USB connector of the Label Writer to any available USB connector on your computer.

4.	 When the Install New Hardware Wizard appears, follow the on‑screen prompts to complete installation.

http://www.adobe.com
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Procedure 3.	 INSTALL SCAN POINT LOCAL CLIENT

1.	 Insert the Software Install CD into your computer’s CD drive.

2.	 If the InstallShield® Wizard does not open automatically, perform the following steps:

•	 Double‑click the My Computer icon on your desktop.

•	 Double‑click your CD drive icon or name.

•	 Double‑click the setup.exe file.

3.	 In the Choose Setup Language dialog box, select your language, and then click OK.

4.	 If a dialog box advises you that Scan Point Local Client requires additional items to be installed, continue 
to Step 5. If not, skip to Step 11.

5.	 Click Install.

6.	 If you are asked whether you want to allow the installer to make changes to the system, click Yes.
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7.	 When you are advised that the installation requires a reboot, click Yes.

8.	 After the computer restarts, log on again.

9.	 If necessary, repeat step 2 in order to resume the installation.

10.	 If the language selection dialog box appears again, choose the language that the wizard should display 
for the remainder of the installation process, and then click OK. A Preparing to Install dialog box may 
appear at this point. 

Note: If you are upgrading an earlier version of Scan Point Local Client, the installer now removes the old 
software. However, it does not remove your program settings, instrument information, or saved exams.

11.	 On the Welcome to the InstallShield Wizard for Scan Point LC page, click Next.
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12.	 On the License Agreement page, select I accept the terms in the license agreement, and then 
click Next.

13.	When the Disconnect Devices dialog box appears, ensure that you have disconnected all Verathon® 
docking stations and wireless hubs from the computer, and then click Next.

14.	On the Destination Folder page, verify that the installation folder and saved exams folder locations are 
correct. If you want to accept the defaults, click Next.

If you want to change a folder, click the Change button for the directory you want to edit, browse to the 
desired location, and then click OK. When you are finished editing the destination folders, click Next.
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15.	On the Ready to Install page, click Install. The software begins to install.

16.	 If you are asked whether you want the program to install the software on your computer, click Yes.

17.	 If the Windows Security dialog box appears, select Always trust software from “Verathon Inc.” and 
then click Install.

18.	 If the InstallShield Wizard Completed page includes a Launch Scan Point LC check box when it appears, 
select the box, and then click Finish.

19.	Remove the Installation CD from your computer’s CD drive and continue to Set Your Initial Scan Point 
Preferences.
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Procedure 4.	 SET YOUR INITIAL SCAN POINT PREFERENCES

1.	 If necessary, double‑click the Scan Point LC icon  on your desktop in order to start Scan Point LC.

2.	 If the Preferences Wizard does not start up automatically, in the Scan Point Local Client window, click 
Tools, and then click Preferences Wizard.

3.	 On the initial Scan Point Local Client Preferences Wizard page, click Next.

4.	 On the Set Optional Defaults page, enter the default operator, physician, and facility names you want to 
appear on scan reports. Select the default report type for each instrument model:

•	 BladderScan® (BVI 6100)

•	 BladderScan Small Child (BVI 6200)

•	 Mobile BladderScan (BVI 6400)

•	 FloPoint® Elite

•	 BVI 9400

When you are finished, click Next.
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5.	 On the System Settings page, indicate whether you want Scan Point Local Client to prompt you for 
details about an exam before processing it.

•	 If you choose to be prompted for exam details, you can enter names for the operator (the person 
who performed the exam) and the physician (the doctor who ordered the exam) in the Operator and 
Physician text boxes that Scan Point Local Client displays when you download each exam from the 
BladderScan® or FloPoint® system. You can then accept the defaults or enter new names before you 
save or print the exam results.

•	 If you choose not to be prompted for exam details, Scan Point Local Client prints and saves the results 
of each exam automatically, without prompting you for exam details. Printed exam reports include 
blank spaces for the patient's name and ID. The default operator and physician names will appear on 
each exam if you have defined them; otherwise, blank spaces will appear for the operator's name and 
the physician's name as well.

6.	 On the Customize AutoPrint Settings page, select whether or not Scan Point Local Client should print 
each exam automatically after receiving it from the instrument. If you select automatic printing, you can 
also choose any combination of the following options:

•	 Printer selection for each report

•	 Type selection for each report

•	 On‑screen report display after printing is complete

When you are finished, click Next.
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7.	 On the Preferences Wizard Complete page, click Finish.

8.	 Connect the docking station or wireless hub to the computer. The computer configures the device drivers 
that were installed along with Scan Point Local Client.

Procedure 5.	 UPDATE SCAN POINT LOCAL CLIENT

Note: This procedure requires an Internet connection.

1.	 In the Scan Point Local Client main window, click Tools and select Check for Updates.

2.	 If a dialog box informs you that you are already running the latest version of Scan Point Local Client, 
click OK. Otherwise, continue to the following step.

3.	 If you are asked if you want to allow 7z Setup SFX to make changes to your computer, click Yes.

4.	 At each of the following two dialog boxes, when you are asked if you want to install the new version of 
Scan Point Local Client and to perform an upgrade, click Yes.
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5.	 On the Resuming the InstallShield Wizard for Scan Point LC page, click Next.

6.	 On the Ready to Install page, click Install. The software begins to install.

7.	 If you are asked whether you want the program to install the software on your computer, click Yes.

8.	 On the InstallShield Wizard Completed page, click Finish. The upgrade is complete.
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UNDERSTANDING THE INTERFACE

This chapter contains information on the Scan Point Local Client main window and its controls and features.

When you start Scan Point Local Client, the Main Window opens. You can access all the features of Scan 
Point Local Client from this window including:

•	 Connecting to an instrument

•	 Annotating new exams

•	 Reviewing saved exams

•	 Searching for existing patients
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MAIN WINDOW CONTROLS
Table 3 provides descriptions of the controls and features found in the Scan Point Local Client.

Table 3.	 Scan Point Local Client Main Window Controls

CONTROL NAME PURPOSE

Scan Point button Opens the my.scanpoint.com login page.*

Past Exams button Opens the Past Exams search dialog box.

Past Exams search 
dialog box

Allows you to search for past exams. For more 
information, see the procedure View Past Exam Records 
on page 20.

Help button
Opens a dialog box with a link to the product manual 
page at verathon.com/product‑documentation, where 
you can download the latest version of this manual.

Instrument image, 
name, and status 
Indicator

Displays the connected instrument and indicates its status 
using one or more of the following symbols:

•	 Highlighted border: Indicates the selected instrument 
when more than one cradle is installed.

•	 Green check mark  : Ready to use.

•	 Blue exclamation point  : Waiting for information.

•	 Red stop sign  : Saving an exam or processing 
information (as also shown by the progress bar). Do not 
remove the instrument from the docking station or 
interrupt the wireless connection.

The instrument name defaults to the instrument's serial 
number. If a user renames the instrument, that name 
appears here instead.

Instrument details 
button

Open the instrument details box. The box provides basic 
information about the device such as part number, serial 
number, and next calibration date.

You can rename the instrument by clicking on the name 
and entering a new one.

Find New button
Click to find a new Docking Station or to connect to a 
BladderScan® BVI 9400 instrument.

*	 This feature requires an Internet connection. If you need to create a Scan Point Online account, please contact Verathon® Customer Care 
or your local representative.

http://my.scanpoint.com
http://verathon.com/product-documentation
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START‑UP MESSAGES
The following messages may appear when the Scan Point Local Client main window is open:

•	 Check for Updates—This message appears if you have not checked for an application update in the 
past three months.

•	 Calibration Reminder—This message appears if system calibration is recommended within the next 
20 days. Please take prompt action to ensure that the system continues to perform properly. For more 
information, refer to the calibration instructions found in your system's operations and maintenance 
manual, available at verathon.com/product‑documentation. For assistance, contact Verathon® 
Customer Care or your local representative.

http://verathon.com/product-documentation/
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USING SCAN POINT LOCAL CLIENT

This chapter contains the following procedures on using Scan Point Local Client:

•	 Connect an Instrument to Scan Point Local Client

•	 Modify Instrument Inventory

•	 View Instrument Details & Configuration

•	 View Past Exam Records

Procedure 1.	 CONNECT AN INSTRUMENT TO SCAN POINT LOCAL CLIENT

If Scan Point does not operate as described in this chapter, please contact Verathon® Customer Care or refer to the 
chapter Troubleshooting & Maintenance on page 39.

When an instrument is connected to Scan Point Local Client, saved exams will automatically begin to transfer. For 
information on saving exams, see the chapter Saving Exams on page 21.

Option 1.	 BLADDERSCAN® 6000 SERIES OR FLOPOINT® ELITE SYSTEMS

1.	 Place the instrument on the Scan Point docking station. The instrument appears in the left pane of the 
Scan Point Local Client window.

Option 2.	 BLADDERSCAN BVI 9400 SYSTEM

1.	 Place the instrument within 3 m (10 ft) of the Battery charger/wireless hub 

2.	 On the instrument, on the Home screen, press the Scan Point button 

3.	 On the computer, in the Scan Point Local Client window, click Find New. Scan Point Local Client establishes 
a connection with the instrument, and an icon for the device appears in the left pane. On the console, two 
arrows appear, confirming that the console is connected to Scan Point.
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Procedure 2.	 MODIFY INSTRUMENT INVENTORY

When an instrument is connected to Scan Point Local Client, it is automatically added to your instrument inventory. 
Complete this procedure in order to rename an instrument, remove an instrument from your inventory, or 
export your inventory list.

1.	 From the View menu, select Instruments. The Instrument Inventory dialog box opens.

Option 1.	 RENAMING AN INSTRUMENT

1.	 Select the part number of the instrument you would like to modify. The instrument is highlighted, and its 
details are displayed.

2.	 In the Name box, enter the new name.

3.	 Click the Close button in order to exit the Instrument Inventory dialog box. Your changes are saved.

Option 2.	 REMOVING AN INSTRUMENT FROM INVENTORY

1.	 Select the part number of the instrument you would like to modify. The instrument is highlighted, and its 
details are displayed.

2.	 Click the Remove button. The instrument is removed from the inventory list.

Note: If an instrument was removed accidentally, reconnect it to Scan Point Local Client in order to add it 
to the inventory list.

3.	 Click the Close button in order to exit the Instrument Inventory dialog box.

Option 3.	 EXPORTING THE INSTRUMENT INVENTORY LIST

1.	 Click the Export button.

2.	 Choose the location that you would like to save the file, and then click the Save button. The inventory 
list is saved as an XML document.

3.	 Click the Close button to exit the Instrument Inventory dialog box.
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Procedure 3.	 VIEW INSTRUMENT DETAILS & CONFIGURATION

The Instrument Details dialog box provides the following information about the device:

•	 Part number

•	 Serial number

•	 Next calibration date (BladderScan® 6000 series and FloPoint® Elite instruments only)

From this dialog box you can prepare your instrument for a new exam (BladderScan 6000 series and 
FloPoint Elite Instruments) and access instrument settings (BladderScan BVI 9400 only)

Option 1.	 VIEWING BLADDERSCAN 6000 SERIES AND FLOPOINT ELITE DETAILS

1.	 Complete the procedure Connect an Instrument to Scan Point Local Client on page 17.

2.	 On the left side of the Main Window, to the right of the Instrument Icon, click the Instrument Details 
button. The Instrument Details dialog box opens.

Option 2.	 VIEWING BLADDERSCAN BVI 9400 DEVICE DETAILS AND CONFIGURATION

Complete this section in order to update the settings on a BladderScan BVI 9400 instrument.

1.	 On the left side of the Main Window, to the right of the Instrument Icon, click the Instrument Details 
button. The Instrument Details dialog box opens.

2.	 Click the Change Configuration button. The Set Instrument Configuration dialog box opens.

3.	 Update the configuration as needed, and then click the Save button.
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Procedure 4.	 VIEW PAST EXAM RECORDS

Complete this procedure to view individual or multiple past exams for review or comparison.

1.	 From the Main Window, click the Past Exams button.

2.	 If you know the patient ID, enter it in the Patient ID box, and then click Go.

If you do not know the patient ID, click Search. In the Select Patient list, click the patient ID, and then 
click OK.

3.	 From the Saved Exams list, select the exams that you would like to view, and then click the Open 
Selected button. The exam results for each selected exam open.
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SAVING EXAMS

This chapter contains procedures for saving exams from BladderScan® or FloPoint® Elite instruments to Scan 
Point Local Client.

If unsaved exam data is not uploaded to Scan Point and the instrument goes into sleep mode or 
turns off, the exam data will be lost.

CAUTION

While exam data is uploading to Scan Point, do not remove the instrument from the Scan Point 
docking station or remove the console battery while data is being uploaded. Scan Point displays 
the percentage of data transferred.

CAUTION

Procedure 1.	 TRANSMIT EXAMS FROM 6000 SERIES & FLOPOINT INSTRUMENTS

Use this procedure in order to transmit exam information from BladderScan BVI 6100, BVI 6200, BVI 6400, 
and FloPoint Elite instruments.

After the instrument transmits exam data, an Exam Record dialog box displays the following:

•	 Title Bar—Displays the name and type of instrument used to perform the scan and the date that the 
scan was performed

•	 Exam Information—Provides fields used for annotating the exam with patient and user information

•	 Search button—Opens a list of existing patient IDs

•	 Listen button—Plays saved voice annotations (BladderScan BVI 6400 instruments only).

Figure 1.	 New Exam Record

Title Bar
Search Button

Exam Information Listen Button

Submit Button
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Option 1.	 PREPARE AN INSTRUMENT FOR A NEW EXAM

Complete this procedure in order to prepare an instrument for its next exam. When the instrument performs 
its next exam and is then placed back on the Scan Point docking station, the exam is automatically transmitted 
with the information entered in the following steps.

1.	 Place the instrument on the Scan Point docking station.

2.	 In the Main Window, to the right of the Instrument Icon, click the Instrument Details button.

3.	 In the Instrument Details dialog box, click the New Exam button.

4.	 In the Preparing Device for Scan dialog box, complete the required fields, and then click the Submit button.

Note: If you would like to select a patient that is already in your database, click the Search button in 
order to bring up a list of existing patients.

5.	 Perform an exam. 

6.	 Place the instrument on the Scan Point docking station.

7.	 The exam automatically starts to upload to Scan Point Local Client. While the exam is transmitting, an 
Exam Information dialog box opens.
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8.	 Ensure that the Exam Information fields are correct, and then click the Submit button. Do not remove 
the instrument from the Scan Point docking station while exam data is being transmitted.

After the instrument has finished transmitting and the exam has been submitted, a green arrow appears 
in the Instrument Icon indicating that it is safe to remove the device.

9.	 Complete the procedure Save or Print an Exam on page 26.

Option 2.	 EXAMS WITH VOICE ANNOTATION

If the instrument is holding an exam that does not have a voice annotation, skip to the next option 
Exams Without Voice Annotation.

1.	 Place the instrument on the Scan Point docking station.

2.	 The exams will automatically start to upload to Scan Point Local Client. Do not remove the instrument 
from the Scan Point docking station while exam data is being uploaded. Once an exam has finished 
transmitting, an Exam Details dialog box opens.

3.	 In the Exam Details dialog box, click the Listen button. The voice annotation plays. Voice annotations 
assist in matching exams to patients.
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4.	 In the Exam Details dialog box, complete the required Exam Information fields, and then click the 
Submit button.

5.	 Complete the procedure Save or Print an Exam on page 26.

Option 3.	 EXAMS WITHOUT VOICE ANNOTATION

Complete this option if the instrument is holding an exam that does not have a voice annotation.

1.	 Place the instrument on the Scan Point docking station.

2.	 The exams automatically starts to upload to Scan Point Local Client. While the exam is transmitting, an 
Exam Details dialog box opens. 

3.	 Complete the required Exam Information fields, and then click the Submit button. Do not remove the 
instrument from the Scan Point docking station while exam data is being transmitted and before the 
Exam Information has been entered.

4.	 Complete the procedure Save or Print an Exam on page 26.
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Procedure 2.	 TRANSMIT EXAMS FROM A BVI 9400 INSTRUMENT

Use this procedure in order to save exam information from a BladderScan® BVI 9400 instrument.

1.	 Place the instrument within 3 m (10 ft) of the Battery charger/wireless hub.

2.	 On the instrument, on the Home screen, press the Scan Point button .

3.	 On the computer, in the Scan Point Local Client window, click Find New. Scan Point Local Client establishes 
a connection with the instrument, and an icon for the device appears in the left pane. On the console, two 
arrows appear, confirming that the console is connected to Scan Point.

The exams will automatically start to upload to Scan Point Local Client. Do not remove the console 
battery while data is being uploaded. The Scan Point Local Client window displays the percentage of 
data transferred. Once an exam has finished transmitting, an Exam Details dialog box opens.

4.	 In the Exam Details dialog box, click the Listen button. The voice annotation plays. Voice annotations 
assist in matching exams to patients.

5.	 Continue to the next procedure in order to save the exam.
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Procedure 3.	 SAVE OR PRINT AN EXAM

Once an exam transmission is complete, the exam must be saved or printed.

1.	 If the Exam Information was added in previous procedure, ensure that the information is correct.

If the Exam Information was not added, complete the required information.

Option 1.	 SAVING AN EXAM

1.	 Click the Save Exam button. 

2.	 The Save As dialog box opens with the exam automatically named as "Patient ID_date_time". If needed, 
you can rename the file.

3.	 In the Save As dialog box, ensure that the save location is the Saved Exams Folder, and then click the 
Save button.

Note: If you create new folders for your saved exams, they must be created within the Saved Exams 
folder in order to appear in the Past Exams list.

Option 2.	 PRINTING AN EXAM

1.	 From the File menu, select Print.

Note: If you would like to preview the record before printing, select Print Preview from the File menu.

2.	 In the Report Type dialog box, select the report type that you would like to print:

•	 Printable Page

•	 Printable Page for Physicians Offices

•	 Printable Page for ECF/SNF

For information on the report types available, see the next chapter Interpreting Images & Reports on 
page 27.

3.	 In the Print Preview dialog box, click the Print button.
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INTERPRETING IMAGES & REPORTS

UNDERSTANDING ORIENTATION ICONS
Exam images generated by BladderScan® instruments feature orientation icons that assist with interpreting 
images. The icon is located at the top left of the ultrasound image. This icon shows the scan plane of the 
displayed image in relation to the probe's orientation.

The scanhead is represented by the large circle and the probe's handle by the rectangle. The white dot in the 
large circle corresponds to the dot displayed at the upper left of the scan image.

Scanhead

Handle

Reference dots

When a scan is taken with the probe handle perpendicular to the patient’s spine and pointing to the patient’s 
right side, the orientation icon will show how the image corresponds to the patient.

Table 4.	 Orientation Icons

ICON MEANING

The scan was taken in the sagittal plane, with the left side of the image toward the 
patient’s feet

The scan was taken in the transverse plane, with the left side of the image toward the 
patient’s right side
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EXAM REPORTS
The exam reports from BladderScan® and FloPoint® Elite instruments can be printed in several different 
formats:

•	 BladderScan:

○○ Printable Page

○○ Printable Page for Physician’s Office

○○ Printable Page for ECF and SNF (Extend Care Facility/Skilled Nursing Facility)

•	 FloPoint Elite:

○○ FloPoint Summary

○○ FloPoint Details

Exam reports contain automatically generated exam information, along with annotations entered when the 
exam was saved. The following pages contain examples of the printable exam reports.

BLADDERSCAN BVI 9400 REPORTS

PRINTABLE PAGE (BVI 9400)

The BladderScan Results report displays exam details and two images.
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PRINTABLE PAGE FOR PHYSICIAN’S OFFICE (BVI 9400)

The BladderScan® Report for Physician’s Office displays exam details, two images, and a diagnostic checklist 
for the physician’s records.
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PRINTABLE PAGE FOR ECF AND SNF (BVI 9400)

The BladderScan® Report for ECF/SNF (Extend Care Facility/Skilled Nursing Facility) displays exam details, two 
images, and a diagnostic checklist for an extended care facility or skilled nursing facility.
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BLADDERSCAN 6000 SERIES EXAM REPORTS

PRINTABLE PAGE (BVI 6000 SERIES)

The BladderScan® Results page includes exam details and six images.
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PRINTABLE PAGE FOR PHYSICIAN’S OFFICE (BVI 6000 SERIES)

The BladderScan® Report for Physician’s Office includes exam details, six images, and a diagnostic checklist 
for the physician’s records.

Figure 2.	 Printable Page for Physician’s Office
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PRINTABLE PAGE FOR ECF AND SNF (BVI 6000 SERIES)

The BladderScan® Report for ECF/SNF (Extend Care Facility/Skilled Nursing Facility) includes exam details, six 
images, and a diagnostic checklist for an extended care facility or skilled nursing facility.

Figure 3.	 Printable Page for ECF and SNF



34

FLOPOINT ELITE EXAM REPORTS

FLOPOINT SUMMARY (FLOPOINT ELITE)

The FloPoint® Summary report includes a summary report including the exam details, Peak Flow 
measurement, and Peak Flow chart.

Figure 4.	 FloPoint Summary Report
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FLOPOINT DETAILS (FLOPOINT ELITE)

The FloPoint® Details report includes a summary report including the exam details, Peak Flow measurement, 
Peak Flow chart, detailed measurements, and a Volume over Time chart.
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PREFERENCES & DEFAULT SETTINGS

The Scan Point Local Client Preferences dialog box allows you to customize the default information. The 
Preferences dialog box contains the following preference tabs:

•	 Exam Defaults—Default operator, physician, and report types

•	 AutoPrint Settings—Auto prompts and autoprint defaults.

•	 System Settings—Language, Update URL, Facility Name, Saved Exams Folder, and Warnings.

Note: You should not change the URL unless directed to do so.

At any time while you are working in the Preferences dialog box, you can restore the original default 
information by clicking the Restore Defaults button.

Note: Alternatively, you can use the Preferences Wizard to set your preferences. From the Tools menu, 
select Preferences Wizard, and then follow the on‑screen instructions.

Procedure 1.	 SET DEFAULT PREFERENCES

EXAM DEFAULTS TAB

1.	 From the Tools menu, choose Preferences. The Preferences dialog box opens.

2.	 Click the Exam Defaults tab.

3.	 In the Default Operator box, enter the default operator name.

4.	 In the Default Physician box, enter the default physician name.

5.	 Select the default report type for each instrument:

•	 BladderScan® (BVI 6100)

•	 BladderScan Small Child (BVI 6200)

•	 Mobile BladderScan (BVI 6400)

•	 FloPoint® Elite

•	 BVI 9400

If you want to see examples of each available report type, click the View Report Type Samples link.
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AUTOPRINT SETTINGS TAB

6.	 If you have not already done so, from the Tools menu, select Preferences. The Preferences dialog box opens.

7.	 Click the AutoPrint Settings tab.

8.	 Select the check box for each option that you want active.

SYSTEM SETTINGS TAB

9.	 If you have not already done so, from the Tools menu, select Preferences. The Preferences dialog box opens.

10.	Click the System Settings tab.

11.	 From the Language list, select the language (English or Japanese) in which you want Scan Point Local 
Client to appear.

12.	 In the Facility Name box, enter the facility name. This name will appear in the header of exam reports.

13.	 Ensure that the Saved Exams Folder is set to the correct location. Click Browse to select a location for 
saved exams.

Note: This folder is also selected during the installation of Scan Point Local Client.

14.	Select the check box for each warning you want active.

15.	Click OK to save your changes and close the preferences dialog box.
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Procedure 2.	 CALIBRATE THE COMPUTER MONITOR

In order to ensure the clearest possible display of B‑mode images, your monitor must be calibrated for 
optimum performance.

Note: If you are using an LCD monitor, avoid high or low viewing angles when performing this test.

1.	 From Tools menu, select Calibrate Monitor. The Calibrate Monitor dialog box opens.

Depending on the current brightness setting of your monitor, you may or may not see a dark circle in the 
first box.

2.	 If you can see a black circle in the first box, decrease your monitor's brightness until the circle just 
disappears.

If you don’t see a dark circle, increase the brightness until the circle is visible and then reduce the 
brightness until the circle just disappears.

The brightness setting is optimum when the circle just barely disappears.
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TROUBLESHOOTING & MAINTENANCE

Verathon® provides an extensive array of customer care resources. To obtain a copy of this manual or Quick 
Reference Cards for an instrument, visit verathon.com/product‑documentation. Product information is 
available at verathon.com.

REAL‑TIME SYSTEM DIAGNOSTICS
If you are experiencing problems, Verathon Customer Care may request permission to view your application 
log. After you consent to send the log to Verathon, the log will be automatically transmitted.

The Application Log, available through the View menu, has a record of all the actions performed by Scan 
Point Local Client. It includes no patient health information. 

Note: This troubleshooting tool requires an Internet connection and a Scan Point Online account.

COMMON ISSUES AND SOLUTIONS
This section contains explanations and suggestions for resolving common problems. If you are unable 
to resolve an issue, please contact Verathon Customer Care or your local representative. For contact 
information, please visit verathon.com/support.

I INSERT THE INSTALLATION CD INTO MY CD DRIVE, BUT THE INSTALLATION WINDOW DOES NOT 
APPEAR.

1.	 In a Windows® browser, navigate to your CD drive.

2.	 Double‑click the setup.exe file.

I DON’T SEE ANY DOCKING STATIONS IN THE SCAN POINT LOCAL CLIENT WINDOW.

Any of the following solutions may resolve this issue:

•	 Check your USB connection. Ensure that the cord from your Docking Station is attached securely to 
your system. 

•	 In the Scan Point Local Client window, click the Find New button.

•	 Try a different USB port.

•	 Restart your computer, and then reopen Scan Point Local Client.

I CAN’T SEE THE SCAN POINT ICON IN MY SYSTEM TRAY. 

The Scan Point Local Client icon does not appear in the system tray when:

•	 The Scan Point Local Client window is open in the background.

•	 You have exited Scan Point Local Client. On your desktop, double‑click the Scan Point Local Client  
icon in order to re‑launch the program.

http://verathon.com/product-documentation/
http://verathon.com/product-documentation
http://verathon.com/support/
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I SEE A CONNECTED DOCKING STATION BUT NOT THE INSTRUMENT.

•	 Remove the device from its Docking Station, wait 3 seconds, and then replace it.

•	 Connect your Docking Station through a powered USB hub.

•	 Restart your computer, and then reopen Scan Point Local Client.

AN INSTRUMENT CANNOT COMMUNICATE WITH SCAN POINT LOCAL CLIENT.

If you are running Scan Point Local Client on a laptop computer, try connecting the instrument through an 
externally powered USB hub. Electric current available through the USB ports on some laptop computers can 
be limited.

I CAN’T FIND CERTAIN EXAM RESULTS. 

Ensure that the exam was saved to the Saved Exams Folder after it was submitted. If an exam is not saved after it 
has been transmitted and submitted to Scan Point Local Client, it will not be shown in the Past Exams list.

GENERAL QUESTIONS

HOW DO I UNINSTALL SCAN POINT LOCAL CLIENT?

1.	 From the Windows® Start menu, open the Control Panel.

2.	 Double‑click the Add or Remove Programs icon.

3.	 In the software list, locate and select Scan Point Local Client, and then click Remove.
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